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What is Network Time?
The Network Time application allows you to set your PC clock from a remote machine running a time 
server. You can use Network Time to set your PC time zone, the time server from which you update your
PC clock, and the frequency of those updates.

You can get a time stamp from one network time server at a time. Network Time uses this time stamp to 
set the time in the internal clock in your PC.

You may need to keep your PC clock synchronized with a remote time server if you

· Are concerned about the integrity of your PC clock.

· Are using Kerberos security, and you need to maintain synchronization with a Kerberos 
authentication server.

· Use NFS client software on your PC to access data on remote NFS server machines.

· Travel with your PC, between time zones.

The Network Time application performs its time stamp retrieval operations using the UNIX time protocol,
as described in RFC 868.

Dialog Box Items
Time Server

Get Time
Set Time
Options

Action Log
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Getting Started
Before you use the Network Time application, be sure that you know the hostname or IP address of at 
least one Internet host that runs a time server.

Related Topics
What is Network Time?
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Authorize a Network Time PC Clock Update
Use the Network Time Set Notification dialog box to update the time on your PC and to open Network 
Time. 

To update the time on your PC, choose OK. This closes the Network Time Set Notification dialog box 
and exits Network Time.

To open Network Time, choose Cancel to close the Network Time Set Notification dialog box. Then, 
press Enter or double-click the Network Time icon.

Dialog Box Items
Would you like Network Time to update your local clock as shown below?

Time Server
Time On Server
Local Time
Time Difference
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Set Your Time Zone
1. From the Time Zone Options box, select a time zone.

2. Choose the OK button to set your PC time zone to your selection.

In the Network Time dialog box, the time zone appears on the Time Zone line.

To display the Time Zone Configuration dialog box, choose Time Zone from the Settings menu.

Note: The Network Time application uses, in the order indicated, the following sources for time zone 
information on your PC:

1. The time-zone= entry in the [pctcp time] section of the PCTCP.INI configuration file

2. The time-zone= entry in the [pctcp general] section of the PCTCP.INI configuration file

3. The DOS TZ global variable

Dialog Box Items
Current Setting
Time Zone Options

Related Topics
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Set Your Time Server
1. In the Network Time dialog box, in the Server box, enter the hostname or IP address of your time 

server.

2. Choose Set Time to accept this time server setting and to query that server.

Note: You can also configure your time server by using the Configure application in advanced mode and
selecting the Internet Addresses Remote Servers screen to modify the time server section.
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Set Network Time for Manual Clock Updates 

1. In the Network Time dialog box, choose the Options button.

2. In the Options dialog box, be sure that the Periodically Update checkbox is blank.

3. Choose the OK button to accept your settings.
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Set Network Time for Periodic Clock Updates 

1. In the Network Time dialog box, choose the Options button.

2. In the Options dialog box, choose the Periodic Update checkbox so that it has an X in it.

3. In the Every Minutes box, enter the number of minutes you want between each PC clock update.

4. Choose the OK button to accept your settings.

Related Topics
Set Network Time for Manual Clock Updates
Set Network Time to Automatically Change Your Clock
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Set Network Time to Automatically Change Your Clock
1. In the Options dialog box, be sure that the Confirm Before Setting Local Time checkbox is blank.

2. Choose OK.

In this mode, when the Network Time application is going to update your PC clock, the application 
displays the Network Time Automatic Set Notification dialog box, giving you 10 seconds to cancel the 
update before updating your PC clock.
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Set Network Time to Prompt You for All Clock Changes
1. In the Options dialog box, select the Confirm Before Setting Local Time checkbox so that it has an X 

in it.

2. Choose OK.

In this mode, when the Network Time application is going to update your PC clock, the application 
displays the Network Time Set Notification dialog box. You must choose OK in this dialog box for 
Network Time to update your PC clock.
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Set Network Time to Prompt You In Case Of Errors 

1. In the Options dialog box, select the Notify User On Error checkbox.

2. Choose OK.

Related Topics
Set Network Time for Manual Clock Updates
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Set Network Time to Log All Messages
1. In the Options dialog box, choose the Log All Events checkbox.

2. Choose OK.

Related Topics
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Set Your Time Server Response Timeout Interval
1. In the Options dialog box, in the Time to Wait for Server Reply box, enter the number of seconds you

want Network Time to wait.

2. Choose OK.

Related Topics
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Display Your Time in 24-hour Mode
1. In the Options dialog box, select the 24-Hour Clock checkbox.

2. Choose OK.
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Update Your Clock Manually
1. In the Network Time dialog box, choose the Get Time button.

The Network Time application obtains the current time stamp from the time server displayed in the 
Server box, and displays any difference between that server time and your local PC clock.

2. Choose the Set Time button.

The Network Time application sets your PC clock to the time obtained from your currently configured 
time server.

Related Topics
Set Network Time for Manual Clock Updates
Set Network Time for Periodic Clock Updates
Set Your Time Server
Set Your Time Zone
Update Your Clock At Windows Startup
Update Your Clock Periodically
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Update Your Clock Periodically
1. Choose the Options button.

2. Choose the Periodically Update checkbox.

3. In the Every Minutes box, enter the interval between PC clock updates.

4. Ensure that the Confirm Before Setting Local Clock checkbox is blank.

5. Choose OK.

6. Minimize the Network Time dialog box.

Related Topics
Set Network Time for Manual Clock Updates
Set Network Time for Periodic Clock Updates
Set Your Time Server
Set Your Time Zone
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Update Your Clock At Windows Startup
1. Copy the Network Time application icon into your Windows Startup group.

2. Choose the Network Time icon from the Windows Startup group.

3. Choose the Options button.

4. Ensure that the Periodically Update checkbox is blank.

5. Ensure that the Confirm Before Setting Local Clock checkbox is blank.

6. Choose OK.

7. Choose the Set Time button to close the Network Time dialog box.

Related Topics
Set Network Time for Manual Clock Updates
Set Network Time for Periodic Clock Updates
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View the Action Log
From the Settings menu, choose Show Log.

The Action Log appears at the bottom of the Network Time dialog box.

Related Topics
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Hide the Action Log
Choose the Show Log option from the Settings menu, and remove the check mark next to the option.

The Action Log disappears from the bottom of the Network Time dialog box.

Related Topics
Set Network Time for Manual Clock Updates
Set Network Time for Periodic Clock Updates
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Stop the Network Time Application
1. In the Network Time dialog box, choose File.

2. Choose Exit.
--or--
Press ALT+F4.

After you choose Exit, the Network Time dialog box closes.

Related Topics
Introduction
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Save Settings
1. From the Settings menu, choose Save Settings on Exit.

2. From the File menu, choose Exit.

Related Topics
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The Time Server Does Not Respond
If you attempt to set your PC clock and you receive the error message

Time server is not responding
it indicates that the time server that you query to update your PC clock may be malfunctioning. Try to 
reach the server using the Ping application.

Related Topics
Introduction
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You Run Out of Network Descriptors
If you attempt to set your PC clock and you receive the error message

Could not allocate network descriptors
increase the number of network descriptors defined in the [pctcp kernel] section of your PCTCP.INI
file. Use the udp-connections= parameter to define the number of UDP descriptors.
Remember that other programs (such as the NFS servers) depend on the use of network descriptors.

Related Topics
Introduction
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You Have a Name Resolution Failure
If you attempt to set your PC clock and you receive the error message

Unable to resolve host name
it indicates that the kernel could not resolve the hostname for your time server. Verify that you have DNS
service on your machine.

In the Time Server box, specify the IP address instead of the hostname for the time server.

Verify that the host is on your network and is running.

Related Topics
Introduction
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The File Menu
From the File menu, use the Exit command to exit from Network Time.

Related Topics
Introduction
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The Settings Menu
Use Settings menu commands to set your time zone, show the Action Log, and save your settings in the
PCTCP.INI configuration file.

Use this command     To do this
Time Zones Choose a time zone for your PC.

Show Log Open the Action Log at the bottom of the Network Time dialog box to display 
messages about time service operations.

Save Settings on Exit Save the most recent settings for Network Time when you exit from the 
application, including the time server, time zone, and all settings displayed in 
the Options dialog box.

Related Topics
Introduction
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What is a Time Server?
A time server is an Internet Protocol host that runs a time server program (usually called timed). A time 
server program provides Time Protocol services to Internet Protocol hosts. Most machines running a 
UNIX operating system provide a time server.

Related Topics
What is a Time Stamp?
What is the Time Protocol?
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What is a Time Stamp?
A time stamp is the current time available from a time server. A time server sends a 32-bit number, 
representing the number of seconds since midnight on January first 1900, to the Network Time 
application.

Related Topics
What is a Time Server?
What is the Time Protocol?
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What is the Time Protocol?
The Time Protocol provides a site-independent, machine-readable date and time to time server clients. 
A time server responds to time protocol queries from clients by sending back a time stamp.

Time Protocol service can be transported over either UDP or TCP.

Time servers usually operate over port 37.

The Time Protocol is described in RFC 868.

Related Topics
What is a Time Server?
What is a Time Stamp?
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How Do I Work with Network Time?
You use the Server box on the Network Time dialog box to set the time server that Network Time 
queries when it updates your PC clock.

You use the Time Zone Configuration dialog box to set the time zone. If you have previously set a time 
zone, the Current Setting box displays the time zone you set.

You use the Options dialog box to set the following configuration options for Network Time:

· How frequently Network Time runs.
· Whether Network Time prompts you for PC clock updates.
· Whether Network Time prompts you online with time server errors.
· Whether Network Time keeps full-time server message logs.
· How long to wait for the updates that you request from your time server.
· Whether to display your PC clock in standard or 24-hour mode.

You can configure the Network Time application to update your PC clock

· Only once. This is the default setting.
· At a set time interval.

If you want to update your PC clock from a network time server, use the Network Time application in 
manual mode.

If you want the Network Time application to run automatically in the background and keep your PC in 
time-synchronization with your time server, set Network Time to run in background mode.

You can have the Network Time application update your PC clock when you start Windows. 

You can configure the Network Time application to

· Change your PC clock automatically. This is the default setting.
· Prompt you when Network Time tries to change your PC clock.

The Network Time application displays error messages in the Action Log. You can choose whether 
Network Time also displays an Error dialog box on the screen when an error condition occurs, requiring 
you to acknowledge those errors.

The Network Time application displays messages about its operations in the Action Log. You can 
choose whether the Network Time application displays

· Only Network Time operation errors, such as time server response timeouts and failures to update 
your PC clock. This is the default setting.

· All Network Time and time-server-related responses and messages, including routine messages 
about successful PC clock updates.

You can set the amount of time that the Network Time application waits for a response to an update 
query sent to your time server. The default period is 5 seconds.

The Network Time application displays your time in standard mode (a.m. or p.m.) by default. You can 
configure Network Time to display your time in 24-hour mode.

You can open the Action Log and view the contents in the Network Time dialog box.

You can save the most recent settings that you make on the Settings menu when you exit from Network 
Time.

Related Topics
Introduction
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Set Options
You can set a number of display and update options here.

Dialog Box Items
Periodically Update
every ... minutes

Confirm Before Setting Local Time
Notify User on Error
Log All Events
Display Time In 24 Hour Format
Time to wait for server reply

Related Topics
Introduction
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time stamp: The current time available from a time 
server.

Time Protocol: Provides a site-independent, machine-readable date 
and time to time server clients. A time server responds to time protocol 
queries from clients by sending back a time stamp.

Time Protocol service can be transported over either UDP or TCP. Time
servers usually operate over port 37. The Time Protocol is described in 
RFC 868.

time server:    An Internet Protocol host that runs a time server program
(usually called timed). A time server program provides Time Protocol 
services to IP hosts. Most computers running a UNIX operating system 
provide a time server.



Network Time Notification dialog box 



Displays the IP address of the 
current time server. If this field is 
empty, you need to enter the IP 
address of the remote server you 
wish to use as your time server.

Displays the server's time.

Displays the time on your PC.

Displays the time difference.

Enter the time server timeout interval 
(in seconds).

Updates the clock periodically.

Enter the interval between updates.

Prompts you for clock updates.

Notifies you when errors occur. If not 
selected, errors are saved only in the log.

Saves all actions in the log. If not selected, 
only errors are saved in the log.

Displays time in 24-hour format.

Displays the local hostname. Network Time gets the local 
hostname form the host-name entry in the [pctcp general] 
section of the PCTCP.INI configuration file.

Displays the currently configured time server.

Gets the current time stamp from your currently configured 
time server.

Sets your PC clock to the current time stamp from your 
currently configured time server.

Goes to the Options menu to let you set configuration 
options.

Displays information about Network Time operations.

The currently configured time zone.

Displays the current time zone setting.

Select a time zone from this list box to reconfigure the time 
zone.



account name: The name or word that identifes who is billed for 
this session on a computer system.

case sensitivity: The ability of a program to evalutate the difference
between the capitalized and non-capitalized versions of a character. 
Case sensitive programs treat for example, cat and Cat, as distinct 
items.

It matters how you enter file and variable names on a case sensitive 
operating system (such as the UNIX operating system). If you want 
to view a file named Cat, and you enter the characters cat,    the 
system displays the file named cat if one exists, or gives you an 
error message. It does not display a file named Cat. Case sensitivity
also effects the way that files are listed when sorted in alphabetical 
order.
.

filename conventions: A TCP/IP network usually contains 
computers that run different operating systems. Each operating 
system has different conventions for naming files. For example, both
the number and kinds of characters that can be used in a name are 
often subject to limits.

When you use some TCP/IP supported services such as telnet and 
ftp, use the filenaming conventions in effect on the host system to 
work with files that are on the host.

hostname: The name of a networked computer. 

The hostname is one form of the computers TCP/IP network 
address; the other is its complete numeric network address.You can 
access a computer by its hostname or its numeric network address.

toolbar: A group of buttons that appears below the menu bar. These
buttons let you gain access quickly to the application's features.

IP address: A number (in the form n.n.n.n    where each n is a value 
in the range 0 to 255) that uniquely identifies a networked computer 
that uses the TCP/IP communication protocol. (The Internet Protocol
is defined in RFC 791.)

MIB-II: The Management Information Base (MIB) database used by 
an SNMP MIB agent to store information about the network 
operations of your PC. MIB-II (or MIB version 2) is the second 
version of the Internet-standard MIB. RFC 1213 defines the format 
of MIB-II.

packet: A single network message with its associated header, 
addressing information, data, and optional trailer. Also known as a 
"frame" or "datagram".

password: A word or string of characters that you supply in order to 
login to another system on a network. Systems that accept the 
username "anonymous" often require you to provide your e-mail 
address as the password.

permissions: On UNIX systems, settings that control who has 
access to a file and what rights (read, write, or execute) are given. 
NFS uses UNIX-style permissions to control access to network files.



protocol window: Some OnNet applications support a window 
dedicated to displaying the interactions between your PC and the 
remote host (the protocol). You can display the window usually from a
View, Settings, or Options menu.

remote host: A networked computer that makes a service available 
to other computers on the network. Typical host services include 
transferring files, printing files, and managing logins from remote 
users.

SNMP community: A relationship between an SNMP agent and one 
or more SNMP management stations.

SNMP community name: A unique name shared by the members of 
an SNMP community.

SNMP message: A packet of data, consisting of an SNMP 
community name and SNMP commands and operands.

status bar: A message area, typically at the bottom of the application 
window, that provides information about the component that is currently 
selected, or the state of the application.

session: A session comprises the interactions between your PC and a 
remote host    beginning with the initial connection and ending when you
or the host explicitly disconnect. 

Some OnNet applications allow you to configure sessions, that is, 
automatically send parameters such as your username and password 
to the remote host..

session definition: The configuration settings for a particular session 
or host connection. A session definition might include such settings as 
the hostname of a computer on the network and your login name for 
that computer, as well as other values that you specify. The set of 
session parameters you can specify differs with each program.

TCP (Transmission Control Protocol): A Transport layer, connection-
oriented, end-to-end protocol that provides reliable, sequenced, and 
nonduplicated delivery of bytes to a remote or a local user. TCP 
provides reliable byte stream communication between pairs of 
processes in hosts attached to interconnected networks.

time out: A period of time when a connection between a PC and a    
host computer is allowed to be idle or unused, or when a PC can 
attempt to make a connection to a networked host.. 

When the time period elapses, the host closes the idle connection, or 
the PC reports that it failed to connect to a host.

UDP (User Datagram Protocol): A Transport layer, connection-less 
mode protocol providing a (potentially unreliable, unsequenced, and/or 
duplicated) datagram communication for delivery of packets to a remote
or a local user. UDP provides a procedure for a process to send 
messages to other processes with a minimum of protocol mechanism.

username: A name required for login to a remote system.

wildcard:    A character such as * or ? that represents one or more 
characters in a filename. In a network, each operating system supports 



its own wildcard characters and syntax. When you use wildcards on a 
remote host, follow the conventions that apply to that host.



Technical assistance

Users in the U.S. and Canada, and worldwide resellers, contact FTP Software®:

Telephone: (800) 382-4387
(508) 685-3600

E-mail: support@ftp.com
Fax: (508) 794-4484

 or 

Users outside of the U.S. and Canada, contact your local reseller.

Tip
For FREE online technical services, see:

World Wide Web: http://www.ftp.com
Anonymous Ftp Server: ftp.ftp.com
Bulletin Board System: (508) 684-6240 ( settings    8,N,1)
CompuServe: GO FTPSOFT (PCVENJ Section 8)




